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ABSTRACT
Physiological environments of the HSC niches exhibit a range of stiffness, ranging from soft
marrow (< 1 Pa) to adipose tissue (1~3 kPa) to non-mineralized bone (> 34 kPa) (Patel, Smith et
al. 2005; Engler, Sen et al. 2006; Discher, Mooney et al. 2009). In order to decouple the effects
of substrate elasticity, ligand concentration, and dimensionality on hematopoietic stem cell (HSC)
fate (quiescence, self-renewal, differentiation, mobilization, homing, and apoptosis), HSCs
harvested from C57B6 mouse femurs and tibias were cultured in or on top of collagen hydrogels
or on top of 2D polyacrylamide (PA) gels with varying mechanics and ligand densities. With
collagen hydrogels and type I collagen-coated PA gels with varying stiffness, simple in vitro
biomaterials system to probe the effects of substrate mechanics on the biophysical properties of
HSCs were created. When cultured for 24 hours, HSCs exhibited varying degrees of changes in
their biophysical properties (cell viability, spread area, cell morphology) with increasing
substrate stiffness. In general, HSCs spread out more and showed more irregular morphology
with increasing substrate elasticity and ligand density. The observed behaviors were different
from those of 32D cells, which are further differentiated 1L-3 dependent murine myeloid
progenitor cells from a cell line, that showed overall much more spread out and amorphous

morphology with optimal spreading at an intermediate ligand density.
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CHAPTER 1: INTRODUCTION AND BACKGROUND

1.1. Hematopoietic stem cells (HSCs)

Hematopoietic stem cells (HSCs) are adult stem cells that reside primarily in the bone marrow
with the capacity to give rise to all cells of myeloid (erythrocytes, platelets, granulocytes,
macrophages, etc.) and lymphoid (T cells, NK cells, B cells, etc.) lineages, as shown in Figure
1.1. A hierarchical system of HSCs and progenitor cells exists, differing in their ability to
reconstruct the bone marrow. Long-term HSCs (LT-HSCs) can engraft lethally-irradiated bone
marrow for at least 6 months while short-term HSCs (ST-HSCs) can only do so for up to 3
months with limited self-renewal capacity. Most further differentiated forms of progenitors

cannot self-renew and are committed to give rise to specific cell types only (Zon 2008).

1.2. HSC niches and intrinsic/extrinsic regulation of HSC fate

Stem cells are housed in a specialized microenvironment known as the stem cell niche, which
provides intrinsic and extrinsic signals to regulate their fate: quiescence, self-renewal,
differentiation, mobilization, homing, and apoptosis (Wilson and Trumpp 2006; Can 2008).
During homeostasis, quiescent HSCs are found at the endosteum (‘endosteal niche’) lined by
osteoblasts and nestin-expressing mesenchymal stem cells (MSCs) that supply factors (CXCL12,
SCF, Ang-1, VACM-1, and TPO) essential for HSC maintenance. More actively cycling HSCs
are located near the center of the bone marrow or in the “perivascular niche,” where they are
associated with CXCL12-abundant reticular (CAR) cells, perivascular MSCs, and sinusoidal

endothelium. Recently, macrophages were discovered to be positive regulators of osteoblasts and



nestin-expressing MSCs, thereby modulating HSC fate (Ehninger and Trumpp 2011). A
schematic of the HSC niches is shown in Figure 1.2. HSCs mobilize and circulate into blood
streams after a traumatic injury. Signaling molecules such as CXCL12 (SDF-1) and B105192
(antagonist to VCAM-1 /VVLA-4 niche interaction) have been found to be able to cause HSC
mobilization in vivo. Alternatively, injection of Granulocyte-colony stimulating factor (G-SCF)

can be used to induce HSC mobilization from the niches (Ross and Li 2009).

Like this, various types of cells that are in close proximity to HSCs along with soluble factors
(growth factors, chemokines, ligands, etc.) present in the niches have been identified to modulate
HSC fate and maintenance by mediating paracrine signaling and other molecular level pathways.
Notably, developmental pathways such as Wnt and NOTCH signaling pathways have been
discovered to be involved with HSC self-renewal. In addition, epigenetic regulation via
chromatin-associated factors (e.g. Bmil), cell-cycle regulators (e.g. PTEN), and blood
transcription factors (e.g. GATAZ2) has also been found to be an integral part of maintaining a
healthy HSC pool (Wilson and Trumpp 2006; Zon 2008). ECM components (ECM proteins and
ECM mechanical properties) have also been found to influence different types of stem cells

(Discher, Mooney et al. 2009), although their effects on HSCs have not yet been elucidated.

1.3. Clinical importance of HSCs
Every year, a large number of people develop and/or suffer from bone marrow and blood-derived
cancers and diseases. These include leukemia, a type of cancer affecting the blood and bone

marrow, lymphoma, a type of cancer affecting the lymphatic system, and myeloma, a type of



cancer affecting the plasma cells of the marrow. Each year, approximately 750,000 people in the
United States are suffering or in remission from one of these potentially fatal conditions. Relapse
after recovery is not uncommon. Incidence rates of cancers typically increase with age, thus the
number of people diagnosed with such conditions is expected to rise as the overall population

grows older with improved life expectancy (lls.org 2011; Ped-Onc.org 2011).

Treatment options vary but usually include extensive chemotherapy, drug therapies, and stem
cell transplantation. Transplantation of functional HSCs harvested from the patient body
(‘autologous transplantation’) would be ideal; however, there are limitations because no well-
established protocols currently exist to effectively expand functional HSCs in vitro or in vivo
without having any adverse effects. HSCs are rare and thus account for only 0.5% the whole

bone marrow population (Wilson and Trumpp 2006; lls.org 2011).

Recent evidence suggests that a small population of cancer-causing ‘leukemic stem cells’ may
exist (Bonnet and Dick 1997; Jan, Chao et al. 2011). These are thought to be normal HSCs that
have been turned malignant due to genetic or other events still unknown. The presence of such
malignant stem cells with long-term self-renewal potential may be the reason why relapse occurs.
On the other hand, it has also been proposed that a population of healthy HSCs still exists in
patients with leukemia, as evidenced by the occurrence of normal hematopoiesis upon the
injection of their stem cells into lethally irradiated mice (Taussig, Miraki-Moud et al. 2008). The
existence of ‘cancer stem cells’ has also been postulated for other types of cancers including
human brain tumors (Singh, Clarke et al. 2003), pancreatic cancers (Li, Lee et al. 2009), and

prostate cancers (Collins, Berry et al. 2005).



Understanding the biological mechanisms of HSC maintenance and regulation would therefore
not only elucidate the pathology of the blood and bone marrow-derived cancers and hence
provide useful and improved treatment options, but also benefit the field of cancers by

contributing to the understanding of cancers in general.

1.4. Mechanical cues in HSC regulation

Unlike cell-cell interactions, the role of mechanical cues in HSC fate regulation has not been
considered until recently. Holst et al. observed that mouse whole bone marrow cells were
enriched in HSC population (Lin"Sca-1"c-Kit") by up to 14.2-fold when they were cultured on
tropoelastin-coated well-plates. This effect was not seen when the mechanosensing ability of the
cells were masked by inhibiting myosin Il heavy chain (blebbistatin) and myosin light chain
kinase (ML-7) or when the effects of tropoelastin were negated via treatment with
glutaraldehyde, thus highlighting the significance of ‘substrate tensegrity’ in HSC regulation

(Holst, Watson et al. 2010).

Recent studies with MSCs suggest that the mechanical properties of the extracellular matrix
(ECM) play an important role in determining stem cell fate. Human MSCs were found to
selectively take neurogenic, myogenic or osteogenic differentiation pathways when they were
cultured on collagen-coated polyacrylamide (PA) gels with varying stiffness mimicking the
stiffness of the brain (0.1 — 1 kPa), muscle (8 — 17 kPa) or the collagenous bone (25 — 40 kPa)

(Engler, Sen et al. 2006). Similarly, myogenic commitment of MSCs was optimized on 25-kPa



and 80-kPa PA gels coated with fibronectin and type I collagen, respectively (Rowlands, George
et al. 2008). Substrate modulus was also found to regulate neural stem cell behavior, favoring
neural differentiation on soft substrates (100 — 500 Pa) and glial cultures on stiff substrates (1 —
10 kPa) (Saha, Keung et al. 2008). Thus, ECM mechanics as well as the presentation of ECM

proteins seem to influence stem cell behaviors.

1.5. Determining the role of substrate elasticity on HSC early-fate regulations

Although Holst et al. showed the importance of ‘substrate tensegrity’ on HSC expansion via
mechanotransduction, other aspects of the HSC niches — substrate elasticity, dimensionality,
ligand density, and ligand presentation — have not been considered until now. Understanding the
relationship between such factors and HSC behaviors would be critical in elucidating the
underlying mechanisms by which HSCs are regulated in their niche microenvironments in order

to supply all of the blood and immune cells for the life span of an animal.

The aim of this study is to decouple the effects of substrate elasticity, ligand concentration, and
dimensionality on HSC fate by culturing HSCs in or on top of collagen hydrogels or on top of
2D PA gels with varying mechanics and ligand densities. Physiological environments of the HSC
niches exhibit a range of stiffness, ranging from soft marrow (< 1 Pa) to adipose tissue (1~3 kPa)
to non-mineralized bone (> 34 kPa) (Patel, Smith et al. 2005; Engler, Sen et al. 2006; Discher,
Mooney et al. 2009). With collagen hydrogels and type I collagen-coated PA gels with varying

stiffness, simple in vitro biomaterials system to probe the effects of substrate mechanics on the



biophysical properties of HSCs were created. The range of stiffness observed in HSC niches are

summarized in Figure 1.3. The schematic of the experimental setup is depicted in Figure 1.4.

1.5.1. Choice of biomaterials

Physiological environments of the HSC niches exhibit a range of stiffnesses, ranging from soft
marrow (< 1 Pa) to adipose tissue (1~3 kPa) to non-mineralized bone (> 34 kPa) (Patel, Smith et
al. 2005; Engler, Sen et al. 2006; Discher, Mooney et al. 2009). It was therefore desirable to
choose a biomaterial whose elastic modulus could be tuned over a wide range of stiffness. It was
also critical that the biomaterial can be easily functionalized with various ECM proteins to
present ligands. In addition, the biomaterial had to be non-cytotoxic in order to encapsulate cells
to provide 3D microenvironments. To meet such requirements, polyacrylamide (PA) gels and
collagen hydrogels have been chosen to serve as a biomaterials platform. PA gels are useful for
providing 2D culture environments with tunable mechanics over a broad range while collagen

hydrogels are advantageous for soft 3D culture environments.

1.5.1.1. Polyacrylamide (PA) gels

Polyacrylamide (PA) is a polymer (-CH,CHCONH,-) that is synthesized from crosslinking
acrylamide and bisacrylamide monomers. It has many advantages which make it a popular
choice for cell studies such as traction, spreading, and migration studies. First of all, it is non-
toxic and is highly water absorbent. It is also clear, which allows for convenient brightfield and
fluorescence imaging. For this purpose, it can be made as a thin and flat 2D gel (< 100 um
thickness) that is covalently attached to a glass substrate underneath it. Most importantly, its

mechanical properties can be easily tuned by varying the concentrations of the acryladmie and



bisacrylamide monomers. Resulting PA gels range from very soft (< 1 kPa) to stiff (> 100 kPa)
gels. Its surface can also be modified to react with primary amine groups of a protein via UV-
crosslinking of Sulfo-SANPAH, a heterobifunctional photoreactive reagent which is employed to
coat the PA gel surface with a protein of choice in order to facilitate cell attachment. One major
drawback of using the PA gels for cell cultures is that the PA gels cannot be made as 3D
constructs to have the cells embedded inside (Pelham and Wang 1997; Beningo, Lo et al. 2002;

Kandow, Georges et al. 2007).

1.5.1.2. Collagen hydrogels

Collagen is a major ECM protein that is an integral part of the connective tissues and many other
types of tissues such as bone, skin, tendon, ligament, and cartilage. Various types of collagen
have been identified, but type I collagen is most abundant in the bone, where HSC niches are
located. Collagen-based biomaterials such as collagen scaffolds have been widely used in tissue
engineering applications due to a number of useful properties: requisite hemostatic properties,

low antigenicity, and appropriate mechanical characteristics (Yannas, Tzeranis et al. 2010).

Collagen hydrogels, on the other hand, are fabricated typically from diluting type I collagen with
the respective culture medium and inducing polymerization through incubation at an elevated
temperature (Baker, Bonnecaze et al. 2009). They are easy to fabricate and can provide very soft
(< 1 kPa) culture environments. It is also possible to make them stiffer to a certain degree by
increasing the collagen concentration or by adding in other elements (e.g. hyaluronan) that could
give additional structural support (Yang and Kaufman 2009). A major advantage with collagen

hydrogels is that cells can be encapsulated inside in order to provide 3D culture conditions.



1.5.2. Choice of cell types

Two types of cells — HSCs and 32D cells — have been chosen for this study.

1.5.2.1. HSCs

Because no cell lines have been established for HSCs, primary cells that are harvested directly
from animals must be used. Primary murine HSCs from femurs and tibias of C57B6 mouse are
therefore chosen. HSCs are collected via fluorescence-activated cell sorting (FACS). Several cell
surface antigens have been identified for the primitive HSC population. LSK (LinSca-1"c-Kit")
population is often used to distinguish HSPCs from other committed cell types (Weissman and

Shizuru 2008). Thus, this population of HSCs was chosen for the HSC experiments.

1.5.2.2. 32D cells

In order to compare HSC behavior with a more committed cell population, 32D cells were used
as a control. 32D cells are interleukin-3 (IL-3) dependent murine myeloid progenitor cells that
are widely used as an in vitro model of hematopoiesis. They terminally differentiate into
neutrophilic granulocytes upon the removal of IL-3 and injection of granulocyte-colony
stimulating factor (G-CSF) to the culture medium, and this differentiation process closely
resembles the differentiation patterns inside the marrow (Valtieri, Tweardy et al. 1987; Agliano,
Santangelo et al. 2000). For this reason, 32D cells are often employed as a model system for

hematopoiesis.



1.6. Thesis Organization

The thesis is organized in the flowing manner:

T

Chapter 2 provides fabrication of collagen hydrogels and PA gels and subsequent
mechanical characterization of these gels via rheology and atomic force microscopy

(AFM).

Chapter 3 presents the biophysical changes observed (changes in cell morphology, % cell
viability, spread area, cell shape index (CSI)) when HSCs were cultured on top of

fabricated PA gels and on top of or inside collagen hydrogels for 24 hours.

Chapter 4 shows the biophysical changes observed in 32D cells when they were cultured

on top of fabricated PA gels and on top of or inside collagen hydrogels for 24 hours.

Chapter 5 summarizes and concludes findings while providing directions for future work,

which can build upon the results of the present work.

Appendix A includes protocols for collagen hydrogel and PA gel fabrication and their

characterization. Appendix B presents protocols for HSC culture and analysis.



1.7. Statistical analysis

One-way analysis of variance (ANOVA) with Tukey test was performed in OriginPro (Origin
Lab Corp., Northampton, MA) to determine statistical differences between data groups. For all
figures, standard error of the mean (SEM) was drawn as error bars. Standard deviation was used

for the elastic moduli of the PA gels.
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1.8. Figures
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Figure 1.1. HSC lineages, showing highly primitive LT-HSCs which can reconstitute an animal
indefinitely, ST-HSCs which can reconstitute an animal with limited self-renewal capacity,
MPPs and other progenitors (CMP, CLP, MEP, GMP, etc.) which are further restricted in their
self-renewal potential, and terminally differentiated cells. LT-HSC: Long-term HSC; ST-HSC:
Short-term HSC; MPP: Multipotent progenitor; CMP: Common myeloid progenitor; CLP:
Common lymphoid progenitor; MEP: Megakaryocyote-erythrocyte progenitor; GMP:
Granulocyte-monocyte progenitor (Passegue, Jamieson et al. 2003).
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Figure 1.2. Endosteal niche, which is near the endosteum, is lined by osteoblasts and nestin-
expressing MSCs while perivascular niche is associated with sinusoidal endothelium and CAR
cells (Ehninger and Trumpp 2011).
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Figure 1.4. Schematic of the proposed experimental design. Cells are to be cultured either on top
of 2D hydrogel substrates or encapsulated inside 3D hydrogel constructs to observe changes in
their biophysical properties and to elucidate the resulting effects on HSC fate decision processes.
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CHAPTER 2: FABRICATION AND MECHANICAL CHARACTERIZATION OF
POLYACRYLAMIDE GELS AND COLLAGEN HYDROGELS

2.1. Introduction

The aim of this study is to decouple the effects of substrate elasticity, ligand concentration, and
dimensionality on HSC fate (quiescence, proliferation, differentiation, mobilization, homing,
apoptosis) by culturing HSCs in or on top of collagen hydrogels or on top of 2D PA gels with
varying mechanics and ligand densities. Therefore, collagen hydrogels and PA gels were

fabricated and mechanically characterized prior to performing any cell culture experiments.

2.2. Collagen hydrogels

Collagen hydrogels, whose mechanical properties can be tuned based on polymerization
temperature, polymerization pH, collagen density, and crosslinking of the collagen fibrils (Raub,
Suresh et al. 2007), were created to give soft (< 1 kPa) 2D or 3D culture environments for HSCs
and 32D cells. The mechanics of collagen hydrogels were determined using rheology. This
section describes the fabrication and mechanical characterization methods employed for collagen

hydrogels. Resulting mechanical data is summarized in Section 2.4.

2.2.1. Fabrication of collagen hydrogels

Collagen gels were fabricated with type I collagen from rat tail (BD Biosciences, Bedford, MA)
according to protocols published elsewhere (Baker, Bonnecaze et al. 2009; Yang and Kaufman
2009). In brief, collagen stock solution (8.25 mg/mL to 9.33 mg/mL) was diluted with the

corresponding culture medium to a final concentration of 1.45 or 2.9 mg/mL. To bring the pH to

14



7.4, 50 uL of 1 M HEPES buffer and appropriate amounts of 0.4 M NaOH were added to the
collagen mixture according to previously established calibration curves (data not shown). The
solution was placed on a 10-mm or 14-mm glass bottom dish (MatTek Corp., Ashland, MA) and
was incubated for at least 2 hours in a humidified 37 °C incubator for complete polymerization
before cells were seeded on top. Alternatively in order to encapsulate cells inside these gel
constructs, a cell suspension containing the desired number of cells was added to the collagen
hydrogel mixture in place of the cell-free culture medium at the start of the culture. All reagents
required for collagen gel fabrication were pre-cooled to 4 °C before use to prevent any premature

collagen gelation upon mixing. Refer to Appendices A.1. and A.2. for more details.

2.2.2. Imaging of collagen hydrogels via scanning electron microscope (SEM)

Fabricated collagen gels were imaged with scanning electron microscope (SEM). Due to their
extremely soft nature, the hydrogels had to be snap frozen with liquid nitrogen and freeze dried
prior to imaging. Snap freezing with liquid nitrogen protected the collagen fiber structures from
being destroyed before the freeze drying step. A complete protocol in taking SEM images is
outlined in Appendix A.3. SEM images revealed detailed crosslinked collagen fiber structures,
as can be seen in Figure 2.1. Differences in the microstructure (i.e. pore size) are observed from
the SEM images based on the collagen concentration of the gels. Stiffer collagen hydrogels
showed smaller pores due to higher levels of collagen fiber crosslinking. In other words, the

stiffness of collagen hydrogels increased with increasing levels of crosslinking.
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2.2.3. Mechanical characterization of collagen hydrogels

The elastic moduli of collagen gels were determined with the Bohlin C-VOR rheometer
(Malvern Instruments, Westborough, MA) in oscillatory mode with a fixed frequency of 1 Hz
and an applied strain of 1%. A small volume of collagen gel mixture (350 pL) was first prepared
as described in the section 2.2.1 then placed on a 25 °C rheometer stage, below a 4° 20-mm cone
geometry with a solvent trap. The cone was then lowered to a pre-determined height (150 um)
and excess collagen around the cone was removed. Using the built-in temperature control
system, the temperature of the stage was raised to 37 °C to induce faster polymerization. The
Bohlin software was then set up to perform a three-minute oscillatory test at every twenty-minute
interval for a total of 12 hours to determine the kinetics of collagen gelling. The test was set to
run only intermittently in order to minimize any disturbance on the fibrillar networks of the
collagen fibers. Data were then plotted, and the elastic moduli of the equilibrated regions were
averaged to yield the mean elastic moduli of the collagen gels. Data from one such trial is shown

in Figure 2.2. Details of rheological measurement procedures are presented in Appendix A.4.

2.3. Polyacrylamide (PA) gels

Polyacrylamide (PA) gels were fabricated to serve as 2D substrates for cell cultures. Although
they cannot serve as 3D constructs, they provided 2D substrates over a wide range of stiffness
(~1 kPa - ~200 kPa). PA gels were fabricated according to published protocols (Pelham and
Wang 1997; Tse and Engler 2010) and probed with AFM to characterize their mechanics.

Resulting mechanical data is summarized in Section 2.4.
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2.3.1. Fabrication of PA gels

PA gels were fabricated according to published protocols (Pelham and Wang 1997; Tse and
Engler 2010). Briefly, the glass microwell of a 14-mm glass bottom culture dish (MatTek Corp.,
Ashland, MA) was reacted with NaOH and subsequently aminosilanized with 3-
aminopropyltrimethoxysilane. A solution of acrylamide/bis-acrylamide was prepared by mixing
acrylamide and bis-acrylamide at varying concentrations and adding ammonium persulfate
(17200 v/v) and tetramethylethylenediamine (1/2,000 v/v) to induce polymerization. This
solution was placed on top of the silanized glass microwell. A pre-chlorosilanized 12-mm
circular coverslip (Fisher Scientific, Pittsburgh, PA) was placed on top of the mixture to ensure
the formation of an even gel surface. For complete polymerization, the dish was incubated for 30
minutes at 37 °C. The coverslip was then carefully removed and the gel was rinsed thoroughly
with deionized water. Using this fabrication technique, PA gels with the following acrylamide
(v/v %)/bis-acrylamide (v/v %) concentrations were created: 4/0.03, 5/0.1, 5/0.26, 10/0.3 and
38/2. Fabricated PA gels were stored at 4 °C until needed. For more detailed procedures, please

refer to Appendix A.5.

A schematic of the chemistry behind the PA polymerization reaction is shown in Figure 2.3.
Ammonium persulfate is a strong oxidizing agent that generates free oxygen radicals.
Tetramethylethylenediamine (TEMED) is a catalyst that stabilized free radicals and facilitate
polymerization. Photoinitiators such as Irgacure 2959 can alternatively be used to induce PA gel

polymerization (Pelham and Wang 1997; Kandow, Georges et al. 2007; Tse and Engler 2010).
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2.3.2. PA gel surface functionalization with type I collagen

PA gels can be functionalized with any proteins with primary amine groups. For the purpose of
this study, PA gels were coated with type I collagen via UV crosslinking. First, Sulfo-SANPAH
(Fisher Scientific, Pittsburgh, PA) solution was placed on top of the gels. The gels were then
exposed to UV (365 nm) for 6 minutes and rinsed twice with 50 mM HEPES, pH 8.5. This
procedure was repeated one more time before type I collagen from rat tail (BD Biosciences,
Bedford, MA) at a desired concentration (100 ug/mL, 40 pg/mL, or 1 ng/mL dissolved in 50 mM
HEPES, pH 8.5) was deposited on the surface of the activated gels. Collagen solution was left to
react with the PA gels overnight at 4 °C. Prior to use, PA gels were rinsed with PBS and
sterilized with UV for 30 minutes. Protocol for PA gel surface protein conjugation is found in

Appendix A.6.

The detailed chemistry of conjugation through Sulfo-SANPAH is outlined in Figure 2.4. It
contains a phenylazide group at one end that reacts nonspecifically with PAgel when
photoactivated, and a sulfosuccinimidyl group at the other end that reacts selectively with
primary amine groups. This reaction requires photoactivation with UV and a pH of 8.5 (i.e.
HEPES buffer at pH 8.5) for conjugation reaction to occur. Because most cell culture mediums
are at the physiological pH of 7.4, it can be ensured that no further reaction occurs once the

protein conjugation step is completed (Kandow, Georges et al. 2007; Tse and Engler 2010).

2.3.2.1. Quantification of the PA gel collagen-coating

As outlined in Appendix A.7., conjugation of type | collagen on PA gel surface was quantified

via immunofluorescence as previously reported (Engler, Bacakova et al. 2004; Engler, Richert et
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al. 2004). Specifically, 200 pL of 1 ng/mL, 40 pg/mL, and 100 pg/mL type | collagen solutions
were deposited onto 14-mm glass bottom culture dishes and left to dry overnight. These
corresponded to 12.9922, 5.1969, and 0.0001 pg/cm?. The next day, these collagen-deposited
substrates were incubated in 2% BSA in PBS for 45 minutes to block nonspecific binding. After
carefully rinsing with PBS, the dishes were incubated with primary collagen antibody (Abcam,
Cambridge, MA) for 1 hr and with Alexa Fluor® 568 secondary antibody (Invitrogen, Carlsbad,
CA) for 45 minutes. The samples were rinsed with PBS and imaged with LSM 710 (Carl Zeiss
AG, Thornwood, NY) to create a calibration of the fluorescence intensity with varying type |
collagen concentration (Figure 2.5.A.). Rinsing steps potentially washing away deposited

collagen was assumed to be negligible.

Collagen-coated PA gels were prepared for immunofluorescence the same way and imaged to
compare with the calibration curve to establish the amount of the cross-linked collagen. The
resulting curve is shown in Figure 2.5.B., and the amount of surface-bound collagen was 0.024,
0.489, and 1.364 pg/cm? for 1 ng/mL, 40 pg/mL, and 100 pg/mL collagen solutions used.
Throughout this thesis, amounts of collagen deposited on PA gels will be referred by the

collagen solution (amount/volume) used.

2.3.3. Mechanical characterization of PA gels

Atomic force microscopy (AFM) was used to generate force-indentation curves at multiple
contact points (N = 15) on PA gel substrates (N = 2-3) in order to determine substrate elastic
moduli. AFM is a powerful and versatile technique that can be used to study soft gels and
biological samples via imaging and/or force measurement. It provides topographical images at

nanoscale resolution or allows the exertion of small forces (nN scale) on samples, with a power

19



to scan molecular level samples such as DNA or binding force between single molecules
(Domke and Radmacher 1998). For purposes of PA gel mechanical characterization, AFM was

used as a nanoindenter measuring the elastic properties of the PA gel samples.

Briefly, AFM MFP-3D manufactured by Asylum Research (Santa Barbara, CA) was used, with
PA gels pre-soaked in deionized water till saturation. A silicon nitride probe with a pyramidal tip
and a nominal spring constant of 0.06 N/m (DNP-S10; Bruker Corp., Camarillo, CA) was used
to make 2-um indentations on the PA gel surface in liquid contact mode. Resulting force-
indentation plots were saved for post analysis. Appendix A.8. details procedures for using AFM
to take force measurements. Force profiles were collected and fitted with the Hertz cone model
to compute the elastic moduli of the corresponding PA gels. Figure 2.6. shows an example of the

saved force curve.

2.3.3.1. Hertz model to calculate Young’s moduli of PA gels

For a conical tip indenting a flat sample, Sneddon’s formula for the Herz model with a conical
tip shape can be used (Radmacher 1997; Mahaffy, Shih et al. 2000; Gavara and Chadwick 2010)

to describe the relationship between the loading force F and the indentation ¢, which is given by:

F = (3)[ £ ]52 tana (Equation 2.1.)

) L(1-v2)

where E is the Young’s modulus, v is the Poisson ratio, and « is the opening angle of the tip.
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By assuming Hooke’s law, which states that the loading force F is directly proportional to the
deflection of the cantilever (d) by a factor of k or the force constant of the cantilever, the

following equation can be obtained:

F=kd =k(z—-9) (Equation 2.2.)

For samples other than an infinitely stiff sample where d = z, the deflection of the cantilever (d)
can be found by subtracting indentation (6) from the piezo movement in the z direction (z)

(Domke and Radmacher 1998; Carl and Schillers 2008).

By combining these two equations and applying it to the obtained force curve, it is possible to

calculate Young’s modulus via the following resulting equation:

z—2zyp=d—dy,+ J(Z)[(kgdz—)]fi;jtana (Equation 2.3.)

where dy is the zero deflection and z, is the contact point (Domke and Radmacher 1998). Two
data points (dy, z1) and (d,, z,) defining a range of analysis can be assigned as shown in Figure

2.7. for this purpose.

Although geometry is different, AFM force measurements with a pyramidal-shaped AFM tip
touching a flat surface (i.e. thin gel) can be approximated using the Hertz model described above.
Sharp tips (pyramidal shape) may result in slightly higher Young’s moduli than conical tips

when the same samples are probed (Carl and Schillers 2008).
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Using the Hertz cone model, elastic moduli of three different PA gels with the following
acrylamide (v/v %)/bis-acrylamide (v/v %) concentrations (v/v%) were calculated: 5/0.1, 5/0.26,
and 38/2. These values were well-correlated with previously reported data (Tse and Engler 2010).
To assess the effect of collagen-coating on the substrate stiffness, PA gels (38%/2%) were coated
with three different collagen-coating densities (100 pg/mL, 40 ug/mL, or 1 ng/mL) and tested

with AFM. There were no statistical differences between these samples (Figure 2.8).

2.4. Results summary

Rheological measurements of the collagen hydrogels revealed their polymerization kinetics,
which showed a rapid polymerization phase that took place for the first two hours. The elastic
moduli of the collagen hydrogels remained stable once this initial polymerization phase was
complete (Figure 2.2.). The averaged elastic moduli of the two collagen hydrogels (1.45 mg/mL;

2.9 mg/mL) used in cell cultures are shown in Table 2.1.

Elastic moduli of the three fabricated PA gels (acrylamide (v/v %)/bis-acrylamide (v/v %)
concentrations: 5/0.1, 5/0.26, and 38/2) were computed from force indentation curves acquired
via AFM. The Poisson ratio (v) was assumed to be 0.4, which is within the published range of v
=0.3 - 0.5 for PA gels (Engler, Bacakova et al. 2004). The calculated elastic moduli were well-
correlated with previously reported values (Tse and Engler 2010); thus, all other PA gels (i.e.
4%/0.03%) fabricated were assumed to hold moduli as previously published. In summary, the

fabricated PA gels had Young’s moduli ranging from 0.71 kPa to 196 kPa (Table 2.2.).
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The effect of collagen conjugation and collagen-coating density on PA gel stiffness was assessed
by comparing the elastic moduli of the same PA gels (196 + 54.1 kPa) left uncoated with those
coated with three different collagen densities (100 pg/mL, 40 ug/mL, or 1 ng/mL). There were
no statistical differences (P > 0.05) between uncoated and coated samples, as well as between
samples coated with varying collagen concentrations. Therefore, collagen coating and coating

density had negligible effects on PA substrate elasticity.

Collagen conjugation on PA gel surface was verified and quantified with immunofluorescence.
The amounts of collagen bound to the PA gel surface were 0.024, 0.489, and 1.364 pg/cm? for 1
ng/mL, 40 pg/mL, and 100 pg/mL collagen solutions used. Throughout this thesis, amounts of

collagen deposited on PA gels will be referred by the collagen solution (amount/volume) used.
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2.5. Figures

Figure 2.1. Collagen hydrogels at 1.45 mg/mL (A) and 2.9 mg/mL (B) were imaged with SEM
at 200x magnification. The gels were snap frozen in liquid nitrogen and freeze dried at -4 °C for
18 hours prior to imaging.
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Figure 2.2. Elastic moduli of collagen hydrogels measured from rheology were plotted vs. time.
The gelation kinetics shows that the elastic modulus was saturated and plateaued between 1.5
and 2 hours from when the polymerization was initiated.
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Figure 2.3. PA gel formation from acrylamide monomers and bis-acrylamide crosslinkers.
Ammonium persulfate generates free oxygen radicals in the presence of TEMED, a catalyst

(Kandow, Georges et al. 2007).
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Figure 2.4. Sulfo-SANPAH, a heterobifunctional photoractive reagent becomes photoactivated
when the phenylazide reactive group is exposed to UV. It then forms a nitrene group that reacts
nonspecifically with PA. The sulfosuccinimydyl group at the other end reacts with primary
amine groups of the protein of choice (Kandow, Georges et al. 2007).
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Figure 2.5. Calibration curves for determining the amount of surface-bound collagen. 200 uL of
1 ng/mL — 100 pg/mL collagen solutions were deposited to serve as standards (A).
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Figure 2.6. Force-indentation curve (extraction only) for 8.75 kPa PA gel. The slope of the curve
correlates with the stiffness of the sample. Stiffer samples have steeper curves.
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Figure 2.7. Force-indentation curve with the zero deflection (force) do and the range of analysis
defined by two data points (di, z1) and (d, z2). Analysis on this data yields the contact point z,
and the Young’s modulus E (Domke and Radmacher 1998).
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Figure 2.8. PA gels (38% acryl/ 2% bis-acryl) were coated with three different coating densities
(100 pg/mL, 40 ug/mL, or 1 ng/mL) and probed with AFM to measure their elastic moduli
(shown with standard deviations). The PA gel coating density did not significantly affect the
stiffness of the gels.

28



2.6. Tables

Collagen concentration Elastic Modulus (Pa)
1.45 mg/mL 148+6.1
2.9 mg/mL 44.2 + 10.7

Table 2.1. Elastic moduli of collagen hydrogels were determined via Rheology. Both collagen
hydrogels (1.45 and 2.9 mg/mL) are very soft with E < 1 kPa.

Literaturet Uncoated
%Acryl/%Bis-acrylamide (v/v) Young's Modulus (kPa) Young's Modulus (kPa)
4/0.03 0.71+0.24 -
5/0.10 3.15+£0.85 3.48 £ 0.59
5/0.26 8.58* 8.75+1.21
38/2 - 196 + 54.1

* Extrapolated with reported moduli
+ (Tse and Engler 2010)

Table 2.2. Elastic moduli of PA hydrogels were computed from AFM force measurement data
and compared to previously reported values in the literature
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CHAPTER 3: HSC CULTURE AND OBSERVED BIOPHYSICAL CHANGES

3.1. Introduction

HSCs were harvested from the femurs and tibias of C57B6 mice and were cultured on top of or
inside collagen hydrogels or on top of 2D PA gels with varying mechanical properties for 24
hours then analyzed. Changes observed in HSCs at the end of the 24-h culture are summarized in

this chapter.

3.2. Isolation of HSCs

HSCs were isolated from the femurs and tibias of 4 — 10-week-old female C47BI\6 mice (The
Jackson Laboratory, Bar Harbor, ME) via fluorescence activated cell sorting (FACS). Briefly,
mice were euthanized with carbon dioxide in compliance with the University of Illinois
Institutional Animal Care and Use Committee (IACUC) guidelines. Their femurs and tibias were
then collected, crushed, and filtered through a 40-pum cell strainer (BD Falcon, Franklin Lakes,
NJ) to yield a whole bone marrow cell suspension in PBS supplemented with 2% FBS. Red
blood cells were removed by incubating the cell suspension in ACK lysing buffer (Invitrogen,
Carlsbad, CA) for 15 minutes. Nonspecific binding was inhibited by incubating the cell
suspension with Fc receptor block (CD16/CD32) for 15 minutes. Cells were then labeled by
incubating in a cocktail of antibodies consisting of FITC-conjugated lineage (Lin) antibodies
(CD5, CD45R (B220), CD11b, Anti-Gr-1 (Ly-6G/C), 7-4, Ter-119), PE-conjugated Sca-1, and
APC-conjugated c-Kit. (All antibodies were purchased from eBiosciences, San Diego, CA).

Labeled cell suspension was filtered into a polystyrene round-bottom tube with a 40-um cell
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strainer cap to remove any cell clumps. All steps were performed at 4 °C and cells were
centrifuged at 1400 rpm for 5 minutes and re-suspended in PBS with 2% FBS between steps.
Labeled were cells were sorted using BD FACSAria™ cell sorter (BD Biosciences, San Jose,
CA\) for Lin'Sca-1"c-Kit" cells. Dead cells were excluded with propidium iodide (PI) staining. A

detailed protocol showing HSC harvest procedures can be found in Appendix B.1.

3.3. HSC culture conditions

LSK population (Lin"Sca-1"c-Kit") harvested from mouse BM were seeded at a cell seeding
density of 7,000 — 8,000 cells/sample on 2D PA gels coated with type I collagen (100 pg/mL) or
on top of collagen hydrogels. Alternatively, a cell suspension containing 7,000 — 8,000 cells was
mixed with type I collagen, culture medium, 1M HEPES, and 0.4M NaOH right before the start
of culture to create a 3D collagen hydrogel construct. HSC culture medium was prepared
according to a published method with a slight modification (Lutolf, Doyonnas et al. 2009): a
serum-free Stemline® Il hematopoietic stem cell expansion medium (Sigma, St. Louis, MO) was
supplemented with 100 ng/mL SCF (Stem Cell Technologies, Vancouver, Canada) and 4 ng/mL
FIt-3/FIk-2 ligand (Stem Cell Technologies Vancouver, Canada). HSCs were incubated in a

humidified incubator at 37°C with 95% oxygen and 5% CO, supply for 24 hours.

As a control group, bareglass collagen-coated glass substrates were utilized. Both bareglass

bottom dishes and collagen-coated glass substrates were purchased from MatTek Corp., Ashland,

MA.
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3.4. HSC viability

After 24 hours of culture, cells were incubated in LIVE/DEAD Cell Viability Assay (Invitrogen,
Carlsbad, CA). Stained cells were imaged with Leica DMI14000 inverted microscope with a 40x
objective at five different spots. The numbers of live (calcein, green) versus dead (ethidium
homodimer-1, red) cells at these spots were scored and averaged to obtain the mean cell viability
of the corresponding sample. Protocol for performing viability assay is presented in Appendix

B.2.

Figure 3.2. compares the viability of HSCs cultured on substrates with varying stiffness. HSCs
showed increased viability on 2.9 mg/mL collagen hydrogels with an elastic modulus of 0.0442
kPa. Cell viability was lowest on uncoated glass samples, which suggests that cell attachment to
the substrate through ligand-receptor interactions is important in maintaining HSC viability.

HSCs showed slightly increased viability when cultured on stiffer 2D PA gels.

3.5. Biophysical changes observed in HSCs

At the end of the 24-hour culture, HSCs cultured inside or on top of 3D collagen hydrogel
structures and on top of 2D PA gels were fixed with 3.7% paraformaldehyde and stained to
visualize their actin structures. A detained staining protocol can be found in Appendix B.3.
Stained samples were imaged with a multiphoton laser scanning microscope (LSM 710; Carl
Zeiss AG, Thornwood, NY) with a 63x objective (numerical aperture = 1.4) in order to create 3D
confocal images of the cells attached to the substrates. Zen software (Carl Zeiss AG, Thornwood,

NY) was used for image acquisition.
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3.5.1. Effects of dimensionality (2D vs. 3D) on HSCs

HSCs were seeded on top of 3D collagen hydrogels to provide 2D-like culture conditions or
encapsulated in the same hydrogel constructs for a 3D culture environment. The effects of
dimensionality, although subtle, were observed in terms of cell viability and the level of
cytoskeletal organization. As shown in Figure 3.3., HSCs cultured inside 3D collagen hydrogel
constructs showed decreased cell viability compared to those cultured on top of 3D collagen
hydrogels with the same stiffness. This pattern was observed for both 1.45 and 2.9 mg/mL

collagen hydrogels.

Figure 3.4. shows morphological differences in HSCs cultured on top of collagen hydrogels or
inside collagen hydrogel constructs. Firstly, HSCs cultured on top of or inside stiffer collagen
hydrogels (2.9 mg/mL; 0.0442 + 0.0107 Pa) showed more cytoskeletal development or
cytoplasmic protrusions compared to those grown on top of or inside softer collagen hydrogels
(1.45 mg/mL; 0.0148 + 0.0061 Pa). Secondly, HSCs cultured on top of 3D collagen hydrogels
(‘2D’-like) were more spread out compared to those that were encapsulated in 3D constructs,
which retained more rounded morphology. In stiffer 3D constructs (2.9 mg/mL), HSPCs started
developing thin, filopodial protrusions forming at the cytoplasmic region enriched in F-actin
fibers, although they still maintained overall more rounded morphology compared to those

grown on top of the ‘2D’ equivalents.
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3.5.2. Effects of substrate elasticity on HSCs

The spread area and cell shape index (CSI) of the HSCs cultured on top of ‘2D’ substrates were
calculated via ImageJ from projected 2D images of the cells gathered with confocal microscopy.
Briefly, the images were thresholded and cells defined by the distribution of actin fibers were
outlined in order to compute the spread area and the perimeter of the cells. CSI, which is a

measure of the circularity of a cell, is a dimensionless ratio given by:

CSI = 4m(cell area)

" (cell perimeter)?

(Equation 3.1.)

has values between 0 and 1. CSI approaches 0 as the cell morphology deviates from being a
perfect circle (Thakar, Chown et al. 2008). For all image analyses, single cells not in direct
contact with one another were analyzed. Dividing cells were also excluded. Appendix B.4.
includes a detailed protocol for cell image manipulation using Image J for cell spread area

calculations.

Significant differences were noted in the spread area of HSCs cultured on substrates with varying
elasticity (Figure 3.5.). On top of soft collagen hydrogels with stiffness lower than about 2 kPa,
reminiscent of the stiffness of the marrow and adipose tissue, HSCs spread out more than on the
gels resembling the stiffness of a single cell, which is in the 1-100 kPa stiffness range
(Radmacher 1997), with many cell types exhibiting low kPa Young’s moduli. On really stiff
gels, cells spread out significantly more. However, when ligand was not present as in bareglass
substrates, cells spread out only as much as they did on soft gel samples, suggesting the

potentially importantly role played by substrate ligand density.
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HSCs are small, circular cells with a diameter of only about 5 pm when they are first harvested
from a mouse. Within 24 h of culture, they spread out considerably with increasing substrate
elasticity but maintained relatively circular cell shape throughout, with just a slight decrease in
cell circularity with increasing substrate stiffness (Figure 3.6.). Cells on uncoated glass slides

remained more circular compared to those cultured on collagen-coated glass slides.

3.5.3. Effects of substrate ligand density on HSC morphology

To verify the importance of substrate ligand concentration in dictating HSC biophysical
behavior, three different collagen coating densities (100 ug/mL, 40 ug/mL, 1 ng/mL) were
applied to the 196 kPa PA gels. The results showed a significant decrease in both cell viability
and cell spread area with decreasing ligand coating density (Figure 3.7. (a) and (b)). Moreover,
decreasing collagen-coating density was correlated with increased CSI values, which means that
cells retained more circular morphology as the ligand concentration was dropped (Figure

3.7.(0)).

3.5.4. Effect of substrate stiffness on HSC cytoskeletal density distribution

In 2009, Chowdhury et al. found that applying a local cyclic force on embryonic stem cells
(ESCs) induced cell spreading and downregulation of oct3/4 gene via focal adhesion-dependent
mechanisms. This phenomenon was not seen in further differentiated cells (i.e., mouse
embryonic stem-cell-differentiated cells) which were roughly ten times stiffer than ESCs,
suggesting that the spreading responses were based on the cell material property (cell softness).

F-actin was identified to be one of the essential mediators of the spreading response as F-actin
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densities were inversely related to cell softness (Chowdhury, Na et al. 2009). Cell deformability
study via micropipette aspiration also proposed that cell softness may be a function of the
differentiated state (i.e. stemness) of the cell (Pajerowski, Dahl et al. 2007). Thus, it seemed
appropriate to elucidate the role of F-actin distribution on HSCs cultured on different substrates

to monitor their status in relation to the changes made to their biophysical properties.

In order to verify the role of F-actin distribution on HSCs, F-actin densities were examined in a
way similar to previously reported (Chowdhury, Na et al. 2009). Briefly, F-actin expression
along three different cross-sectional regions of a cell was quantified for HSCs cultured on 2D PA
substrates with varying stiffness. Fluorescence intensity of F-actin over each cross-section
revealed regions of dense actin fibers near the cell edge, evident from the peak formed at the
cortex (Figure 3.8.(A)). In order to eliminate the differences in fluorescence intensity arising
from different laser settings, the peak was normalized with respect to the relative cell length (x)
and baseline intensity (y) (Figure 3.8.(B)). HSCs cultured on 2D PA substrates showed
increasing y as substrate stiffness increased (Figure 3.8.(A)), where increasing y correlated with
increasing F-actin density. However, the differences were masked largely by the internal

normalization of the fluorescence intensity.

3.6. Discussion

3.6.1. Substrate mechanics on HSC fate
While Holst et al (Holst, Watson et al. 2010) recently suggested that substrate tensegrity

provides mechanical signals regulating HSPC expansion, studies on HSC biology through HSC-
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niche interactions have been largely limited to in vivo experiments with knockout or transgenic
mice, and surprisingly little effort has been put in to decouple the effects of mechanics of the

physical environment where HSCs reside.

In vivo, HSCs are exposed to soft tissues such as adipose tissue with a Young’s modulus of only
< 2 kPa (Discher, Mooney et al. 2009) up to collagenous bone with a stiffness of 25 — 40 kPa
(Engler, Sen et al. 2006). 2D PA gels and 3D collagen hydrogels culture system with tunable
mechanical properties, matrix elasticity could be further decoupled from other factors (growth

factors, cell-cell interactions, etc.) in probing HSC fate.

HSPC viability, spread area, and cell shape data give insight on how HSCs might behave in a
microenvironment rich in certain components (i.e., fat-rich environment (< 2 kPa), other cell
types (~3 kPa), hard tissues such as bone (~100 kPa)). HSPC viability was enhanced at 0.0442
kPa (Figure 3.2.), which suggests that HSCs may survive better on softer substrates. In vivo, this
may refer to being in the vascular niche (rich in marrow) versus in the endosteal niche (at the
bone interface). However, HSC viability was low in general due to poorly characterized in vitro
HSC culture conditions. Currently, no well-established protocols exist for maintaining HSCs
viable in culture for a long period of time. Further studies on HSC-matrix interactions utilizing
immobilized growth factors or additional cytokines (IL-3, TPO, etc.) will be useful in finding

optimal HSC culture conditions.

HSC spread area increased significantly with increasing substrate elasticity (Figure 3.5.). When

cultured on stiff substrates (196 kPa), HSCs spread out approximately twice as much as they did
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on substrates with an effective single cell stiffness (3.48 kPa; p < 0.5). HPSCs spread out even
more on collagen-coated glass substrates (Egiass = ~70 GPa; p < 0.001; (Schneider, Francius et al.
2005)), but significantly less on uncoated glass substrates. This suggests that receptor-ligand
interactions as well as substrate elasticity modulate HSC spreading. Overall, HSCs retained
rounded morphology as the cell shape index remained at ~0.6 or greater on all substrates (Figure
3.6.). However, HSCs became slightly more amorphous with higher degrees of membrane
ruffling as substrate stiffness increased. Again, HSCs cultured on uncoated glass substrates
maintained more circular morphology compared to those cultured on collagen-coated glass

substrates.

To further quantify receptor-ligand interactions on HSC behavior, HSCs were cultured on stiff
PA substrates (196 kPa) coated with three different collagen coating concentrations (100 pg/mL,
40 ng/mL, 1 ng/mL). Viability was significantly impacted, with almost no HSCs surviving at 1
ng/mL collagen-coating. HSC spread area also decreased and they remained more rounded with
decreasing collagen coating density (Figure 3.7.). These results imply that HSC binding through
ECM proteins such as type I collagen is important in regulating HSC fate. In future experiments,
HSC interactions with other ECM proteins (fibronectin, laminin, vitronectin) could also be

explored to further characterize HSC-ECM interactions.

Substrate stiffness also affected cytoskeletal density, measured by F-actin fluorescence intensity.

Although changes were masked by internal normalization, there was denser actin organization in

the leading edge of HSCs cultured on stiffer substrates (Figure 3.8.). These differences suggest
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that the stiffness of HSCs themselves may vary with substrate stiffness, although actin fibers

were punctate and did not form stress fibers within 24 hours of culture.

3.6.2. 2D vs. 3D culture system

2D PA gels allow substrate elasticity to be decoupled and tested independently. However, they
do not fully reconstitute in vivo microenvironments where cells are presented with 3D living
conditions. To probe the effect of dimensionality on cells, soft collagen hydrogels were utilized.
Cells were plated on top of these collagen hydrogels or were encapsulated in collagen hydrogel

constructs. This system, however, was limited to low modulus settings (< ~0.5 kPa).

The effect of dimensionality can be observed from the images of HSCs (Figure 3.4.).
Qualitatively, HSCs retained more rounded morphology in 3D collagen constructs. Gene
expression assays or other functional assays to assess the stemness of HSPCs cultured on top of
or inside hydrogels with the same mechanics would be an interesting addition of data that would

quantify the effect of dimensionality on HSC functionality.
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3.7. Figures
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Figure 3.1. HSCs are harvested from femurs and tibias of C57B6 mouse. Identification and
collection of LSK (Lin"Sca-1"c-Kit")population is shown.
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Figure 3.2. % Viability of HSCs cultured on substrates with varying stiffness for 24 hours. First
two columns (0.0148 and 0.0442 kPa) refer to collagen hydrogels. The next four data groups
correspond to PA gel substrates.
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Figure 3.4. HSCs cultured on top of or inside collagen hydrogels for 24 hours were fixed and
stained to visualize morphology and the actin skeletal organization. Images are 2D projected
images of the 3D stacked images obtained via confocal fluorescence microscopy. Scale bar: 5
m.
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Figure 3.5. Spread area after 24-h culture. HSCs were cultured on top of collagen hydrogels and
2D PA substrates for 24 hours then fixed and stained. They were then imaged to calculate their
spread area (A). Representative fluorescence images of HSCs cultured on PA gels with different
Elastic moduli are shown in (B).
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Figure 3.6. CSI after 24-h culture. HSCs were cultured on top of collagen hydrogels and 2D PA
substrates for 24 hours then fixed and stained. They were then imaged to calculate their CSI.
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PA gels coated with three different collagen densities (100 pg/mL, 40 ug/mL, 1 ng/mL) for 24
hours.
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Figure 3.8. Fluorescence intensity of F-actin over each cross-section revealed regions of dense
actin fibers near the cell edge, evident from the peak formed at the cortex (A); Peak
normalization with respect to the relative cell length (x) and baseline intensity (y) (B); CSK
distribution (C).
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3.8. Conclusions

While Holst et al (Holst, Watson et al. 2010) recently suggested that substrate tensegrity
provides mechanical signals regulating HSPC expansion, studies on HSC biology through HSC-
niche interactions have been largely limited to in vivo experiments with knockout or transgenic
mice, and surprisingly little effort has been put in to decouple the effects of mechanics of the

physical environment where HSCs reside.

In vivo, HSCs are exposed to soft tissues such as adipose tissue with a Young’s modulus of only
< 2 kPa (Discher, Mooney et al. 2009) up to collagenous bone with a stiffness of 25 — 40 kPa
(Engler, Sen et al. 2006). 2D PA gels and 3D collagen hydrogels culture system with tunable
mechanical properties (matrix elasticity, matrix ligand presentation) were used to decouple
variables in probing HSC fate. Significant differences in HSC viability and morphology were

observed with varying substrate elasticity.
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CHAPTER 4: 32D CELL CULTURE AND OBSERVED BIOPHYSICAL CHANGES

4.1. Introduction
In order to compare HSC behavior with a more committed cell population, 32D cells were used
as a control. They were cultured using the same collagen hydrogels and PA gels used to culture

HSCs and analyzed.

4.2. 32D cell line

32D cells are interleukin-3 (IL-3) dependent murine myeloid progenitor cells that are widely
used as an in vitro model of hematopoiesis to study hematopoietic cell behaviors including
proliferation, differentiation, and apoptosis. They terminally differentiate into neutrophilic
granulocytes upon the removal of IL-3 and injection of granulocyte-colony stimulating factor (G-
CSF) to the culture medium, and this differentiation process closely resembles the differentiation

patterns inside the marrow (Valtieri, Tweardy et al. 1987; Agliano, Santangelo et al. 2000).

4.3. 32D cell culture conditions

The 32D clone 3 (32D CI3) or CRL-11346 cell line was purchased from ATCC (Manassas,
VA)). Purchased 32D cells were thawed and subcultured according to ATCC protocols in a
complete growth medium prepared by supplementing RPMI 1640 medium, which was modified

to contain 10 mM HEPES, with 1 mM sodium pyruvate, 4.5 g/L glucose, 1.5 g/L sodium
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bicarbonate, and 2 mM L-glutamine, 10% heat inactivated FBS and 10% mouse IL-3 culture

supplement (BD Sciences, Franklin Lakes, NJ).

Similar to HSCs, 32D cells were seeded at 7,000 — 8,000 seeding density on top of 2D PA gels
and 3D collagen hydrogels (‘2D’). Alternatively, a cell suspension containing 7,000 — 8,000 cells
was mixed with type | collagen, culture medium, 1M HEPES, and 0.4M NaOH at the start of
culture to create 3D collagen hydrogel constructs. The cells were incubated in a humidified

incubator at 37°C with 95% oxygen and 5% CO, supply for 24 hours.

4.4. 32D cell viability
Regardless of the substrate stiffness or substrate ligand density with which the 32D cells were
grown, they showed % cell viability of roughly 80% or higher (data not shown). This is expected

because 32D cells are from a well-established cell line.

4.5. Biophysical changes observed in 32D cells
As mentioned in previous sections, 32D cells are murine IL-3 dependent myeloid progenitor
cells from a cell line. 32D cells are not anchorage-dependent cells and the vast majority stays as

small, rounded cells in suspension when cultured for expansion.
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4.5.1. Effects of dimensionality (2D vs. 3D) on 32D cells

Similar to HSCs, 32D cells grown either on top of (‘2D’) or inside (‘3D’) collagen hydrogels
were fixed, stained, and imaged (Figure 4.1.). 32D cells were overall about three times bigger
compared to HSCs cultured for 24h. Also because these cells were from a cell line, their viability
was 80% or greater. 32D cells in 3D constructs were able to develop large cytoplasmic regions
growing outward within 24-h of culture, and these were larger in stiffer (2.9 mg/mL) constructs.
Also, the nuclei of 32D cells in 3D constructs tended to be bent in the direction of the
cytoplasmic protrusions because they could not freely spread out in the x-y plane like those

cultured on top of collagen hydrogels.

4.5.2. Effects of substrate elasticity on 32D cells

32D cells showed a similar trend in cell spreading area with HSCs, with a peak in spread area at
a low stiffness substrate (0.0442 kPa) and increasing spread area with increasing PA gel
stiffness, although the increase was subtle. Interestingly, 32D cells were able to spread out

considerably on bareglass even without the collagen-coating.

32D cells developed more cytoskeletal protrusions around the cell edges, and these deviations
from the cell circularity were reflected in significantly decreased CSI values at increased

substrate stiffness greater than 0.71 kPa (Figure 4.3.).

4.5.3. Effects of substrate ligand density on 32D cells
There was significant spreading and cytoskeletal organization for the 32D cells cultured on

bareglass without any collagen coating, probably because 32D cells overall can attach to
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substrates more strongly to spread out much more compared to HSCs. These results suggested
that these might behave differently from HSCs with varying substrate ligand density, and that is
what was observed when 32D cells were cultured on 196 kPa PA gel substrates with three
different collagen-coating densities: 100 ug/mL, 40 ug/mL, 1 ng/mL. Cell spread area was
optimal at an intermediate collagen coating density (40 ug/mL). Cell morphology was also
deviating most from being a perfect circle at this concentration, as can be seen in Figure 4.4.
Previous studies with smooth muscle cells exhibited similar cell spreading behaviors, where cell

spreading was optimal at an intermediate collagen density (Engler, Bacakova et al. 2004).

4.6. Discussion

32D cells are a hematopoietic progenitor cell line (Bersenev, Wu et al. 2008) that is often used to
study HSPC behavior in vitro. 32D cells can stay undifferentiated indefinitely as long as they are
cultured with an 1L-3 containing medium. Upon removal of IL-3 and introduction of G-CSF,
they terminally differentiate to become granulocytes (Agliano, Santangelo et al. 2000). 32D cells
behaved very differently from HSCs when they were cultured on the same set of collagen
hydrogels and PA gels. Overall, they showed highly amorphous morphology with CSI below 0.4
on substrates with a stiffness greater than 0.71 kPa (Figure 4.3.) as well as being approximately
twice as large as HSPCs after 24 h of culture. Their spread area tended to increase with an
increasing substrate stiffness (Figure 4.2.), but they showed different biophysical patterns when
different ligand concentrations were presented (Figure 4.4.). Their viability was not affected by
decreasing collagen-coating concentration (data not shown) and they spread out most on an

intermediate collagen coating (40 pg/mL). CSI was also lowest at this concentration. These
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results confirm that 32D cells are further differentiated downstream cells that are governed by

different mechanisms.
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4.7. Figures
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Figure 4.1. 32D cells cultured on top of (‘2D’) or inside (‘3D’) collagen hydrogels for 24 hours
were fixed and stained to visualize morphology and the actin skeletal organization. 2D projected
images of the 3D stacked images of the cells are obtained via confocal fluorescence microscopy.

Scale bar: 5 um.
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Figure 4.2. Spread area after 24-h culture. 32D cells were cultured on top of collagen hydrogels
and 2D PA substrates for 24 hours then fixed and stained. They were then imaged to calculate
their spread area. For cell image analysis protocol, refer to Appendix B.4.
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Figure 4.3. CSlI after 24-h culture. 32D cells were cultured on top of collagen hydrogels and 2D
PA substrates for 24 hours then fixed, stained, and imaged to calculate CSI.
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Figure 4.4. Spread area (a) and CSI (b) changes with varying substrate ligand density. 32D cells
spread out most at an intermediate ligand density of 40 pg/mL.
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4.8. Conclusions
32D cells showed similar patterns in spreading (spread area) but different patterns in cell
morphology (CSI) with varying substrate elasticity and substrate ligand density as compared to

HSCs when they were cultured on top of or inside collagen hydrogels and on top of PA gels for

24 hours.
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CHAPTER 5: CONCLUSIONS

5.1. Conclusions

Collagen hydrogels and PA gels were fabricated and mechanically characterized via rheology
and AFM to give substrate stiffness ranging from < 1 kPa to ~200 kPa. HSCs harvested from
C57B6 mouse femurs and tibias and 32D cells, IL-3 dependent murine myeloid progenitor cells
(cell line) were cultured either on top of or inside collagen hydrogels or on top of collagen-
coated PA gel substrates. Changes in viability, spread area, morphology, and cytoskeletal
reorganization were observed in cultured cells. Substantial differences between HSCs and 32D

cells were also discovered, especially regarding substrate ligand presentation and ligand density.

By further elucidating the effects of substrate elasticity (especially physiologically relevant range
of stiffness) and combining the results with those gathered from cell-cell or cell-growth factor
interaction studies, it will eventually be possible not only to gain a better understanding of the
HSC regulation mechanisms but recreate the HSC niches in vitro for precise control of HSC fate

for various clinical applications.

5.2. Future work

The next objective to be completed is to check the functionality of cultured HSCs using
methylcellulose-based colony forming cell (CFC) assays. This assay allows the detection of the
presence of primitive HSCs and/or more committed progenitors by counting the number of CFCs
formed at day 10-12 of culture. It is an alternative to validating functionality of HSPCs with

lethally irradiated mouse models.
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HSC-ECM interactions will further be analyzed by using other ECM proteins (fibronectin,
laminin, and vitronectin). A gradient PA gel with varying stiffness and a gradient of immobilized
surface protein is also being investigated and considered for future studies of cell-ECM

interactions and chemokine-induced cell migration studies.

Similar to what Holst et al. showed, whole murine BM cell cultures will also be analyzed for
HSC expansion and differentiation. After these studies are performed and analyzed, gene
expression of the cultured cells will also be carried out to monitor any up- or down-regulation of

stem-cell specific genes.
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APPENDIX A: GEL FABRICATION AND CHARACTERIZATION PROTOCOLS
A.1. Collagen hydrogel fabrication protocol
REFERENCES: (Baker, Bonnecaze et al. 2009; Yang and Kaufman 2009)

SUPPLIES
Type | collagen from rat tail (BD Biosciences, Bedford, MA); Respective cell culture
medium; 1M HEPES buffer; 0.4 M NaOH; 10-mm or 14-mm glass bottom dish (MatTek
Corp., Ashland, MA)

EQUIPMENT
Biological safety cabinet; pH meter; 37 °C incubator

PROCEDURE

NOTE: Pre-cool all reagents required for collagen gel fabrication to 4 °C before use to prevent
any premature collagen gelation upon mixing.

1. Dilute collagen stock solution (8.25 mg/mL to 9.33 mg/mL) with the respective cell culture
medium to bring the final concentration to 1.45 or 2.9 mg/mL, as desired. Make 1-mL or 2-mL
working volume of the collagen mixture.

2. Add 50 pL of 1 M HEPES buffer and appropriate amounts of 0.4 M NaOH to bring the pH to
7.4 according to previously established calibration curves. An example of such curve is shown
below. Mix well.

Calibration curve using 2 mL base
volume
__ 80
3 60 - Yy=32x-34
® 40 | R?=0.9846
S
3 20 -
o
> 0 T T
CI> 20 0 1 2_ 3 4
ch Collagen density (mg/mL)

Figure A.1. Calibration curve showing the amount of 0.4 M NaOH that needs to be added to the
collagen mixture (2-mL working volume) in order to bring the pH to7.4.

3. Place the collagen mixture onto a 10-mm or 14-mm glass bottom dish.

4. Incubate for at least 2 hours in a humidified 37 °C incubator for complete polymerization.
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A.2. Collagen hydrogel cell encapsulation protocol
REFERENCES: (Baker, Bonnecaze et al. 2009; Yang and Kaufman 2009)

SUPPLIES
Type | collagen from rat tail (BD Biosciences, Bedford, MA); Respective cell culture
medium containing a desired number of cells; 1M HEPES buffer; 0.4 M NaOH; 10-mm
or 14-mm glass bottom dish (MatTek Corp., Ashland, MA)

EQUIPMENT
Biological safety cabinet; pH meter; 37 °C incubator

PROCEDURE

NOTE: Pre-cool all reagents required for collagen gel fabrication to 4 °C before use to prevent
any premature collagen gelation upon mixing.

1. Dilute collagen stock solution (8.25 mg/mL to 9.33 mg/mL) with the respective cell culture
medium containing a desired number of cells to bring the final concentration to 1.45 or 2.9
mg/mL, as desired. Make 1-mL or 2-mL working volume of the collagen mixture.

2. Add 50 pL of 1 M HEPES buffer and appropriate amounts of 0.4 M NaOH to bring the pH to
7.4 according to previously established calibration curves. An example of such curve is shown in
Figure A.1. (Appendix A.1.).

3. Place the collagen mixture onto a 10-mm or 14-mm glass bottom dish.

4. Place it in a humidified 37 °C incubator. Collagen gel will polymerize and give 3D structural

support to the encapsulated cells. In addition, the culture of embedded cells is initiated at this
point.
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A.3. SEM imaging of collagen hydrogel protocol

SUPPLIES
Type | collagen from rat tail (BD Biosciences, Bedford, MA); Respective cell culture
medium; 1M HEPES buffer; 0.4 M NaOH; Liquid nitrogen

EQUIPMENT
SEM (JEOL JSM-6060LV Low Vacuum SEM, JEOL Ltd., Tokyo, Japan); Freeze dryer
(VirTis Genesis, Gardiner, NY)

PROCEDURE

1. Make collagen gel solution to be analyzed according to the procedures detailed in Appendix
Al

2. Pour liquid nitrogen directly on top of the fabricated collagen hydrogel to snap freeze it.
3. Quickly move the gel to a pre-cooled (4 °C) freeze-dryer and freeze dry it for 18 hours.

4. Take SEM images of the prepared gel at 200x magnification, 20 kV, and 10 Pa.
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A.4. Collagen hydrogel mechanical characterization protocol

REFERENCES: (Baker, Bonnecaze et al. 2009; Yang and Kaufman 2009)

SUPPLIES
Type | collagen from rat tail (BD Biosciences, Bedford, MA); Respective cell culture
medium; 1M HEPES buffer; 0.4 M NaOH

EQUIPMENT
Bohlin C-VOR rheometer (Malvern Instruments, Westborough, MA) with a built-in
temperature bath for temperature control

PROCEDURE

NOTE: Pre-cool all reagents required for collagen gel fabrication to 4 °C before use to prevent
any premature collagen gelation upon mixing.

1. Prepare collagen gel solution according to the procedures detailed in Appendix A.1. Make at
least 350 pL to analyze.

2. Zero the rheometer (i.e. gap height = 150 pL). Attach a 4° 20-mm cone geometry.
3. Cool the stage to 25 °C.
4. Place 350 pL of the collagen solution onto the center of the pre-cooled stage.

5. Lower the 4° 20-mm cone geometry down to press the loaded collagen solution. Excess
solution around the cone can be trimmed using Kimwipes.

6. Place two small sponges soaked with water on the inside of the solvent trap. Carefully place
the solvent trap on top of the loaded collagen gel sample and the cone in order to prevent
evaporation during analysis.

7. Open the Bohlin software and adjust settings on the software. Choose oscillatory mode with 1
Hz and 1% strain rate. Also set the software so that rheological measurements will be taken for
three consecutive minutes every 20-min intervals.

8. Start the measurement. Raise the temperature of the stage to be 37 °C as soon as the test is
started. Temperature will be kept at 37 °C throughout the remainder of the measurement.

9. Software records moduli data over a 12-hr test period.
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A.5. PA gel fabrication protocol
REFERENCES: (Pelham and Wang 1997; Tse and Engler 2010)

SUPPLIES

35 mm glass bottom culture dishes (MatTek Cat # P35G-0-14-C; 14mm microwell)

Circular glass coverslips (Fisher Cat # 12-545-80; 12mm in dia.)

0.1N NaOH

3-aminopropyltrimethoxysilane (keep from moisture)

30 v/v% acrylamide stock solution (light sensitive); from acrylamide powder (Sigma)
3.39g acrylamide in 10 mL solution; density = 1.13 g/cm®

0.5% glutaraldehyde in PBS (store at 4C)
0.625 mL of 8% stock solution + 9.375 mL of 1x PBS = 10 mL 0.5% solution
3.125 mL of 8% stock solution + 46.875 mL of 1x PBS = 50 mL 0.5% solution

10% APS (make fresh solution every month; keep from light)
1.9g APS in 10mL solution; density = 1.9 g/cm®

Tetramethylethylenediamine (TEMED)

Acryl/bis-acryl mixture (light sensitive); Fisher Cat# AC33020-1000

50 mM Hepes (pH 8.5)

dichlorodimethylsilane (DCDMS)

DI water

EQUIPMENT
37° incubator; Vortex

PROCEDURE

Day 1.

1. Pipette 200-400 uL of 0.1N NaOH onto each glass substrate of a glass bottom culture dish.
Sufficient NaOH should be added to cover the entire glass surface.

2. Leave it overnight to dry. Evenly distributed crystals should form on the surface by Day 2.

Day 2:

1. Pipette 100 uL of 3-aminopropyltrimethoxysilane (silanizing agent) onto the NaOH-
crystallized glass substrate. Let it dissolve the previously formed NaOH crystals completely.

2. Wait 5 minutes then wash 2x with deionized water.

3. Pipette 200 uL of 0.5% glutaraldehyde in PBS onto the glass substrate. Let it sit for 30
minutes then wash 2x with deionized water.

4. Remove excess liquid with Kimwipes and leave the dish to air dry completely.
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5. Make a PA mixture.
Take 994.5 uL of acryl/bis mixture solution of a desired concentration.
Add 5uL of 10% APS (1/200 vol.), 0.5uL of TEMED (1/2,000 vol.) into the mixture.
Vortex thoroughly.

Acryl % Bis % (v/v) | Elastic modulus | Dilution
(VIv)
4 0.03 0.71 kPa* Acryl/bis stock = 0.15 mL

30% acryl = 1.143 mL

DI water = 8.707 mL

5 0.1 3.48 kPa Acryl/bis stock = 0.5 mL
30% acryl =1.033 mL

DI water = 8.467 mL

5 0.26 8.75 kPa Acryl/bis stock = 1.3 mL
30% acryl =0.020 mL

DI water = 8.680 mL

38 2 196 kPa 100% Stock solution
(Don’t incubate this conc.)

*From literature

Table A.1. Acrylamide/bis-acrylamide concentrations required to make PA gels with a desired
elastic modulus.

6. Quickly place 15 uL of acrylamide/bis-acrylamide mixture onto each glass substrate.
10 uL ~ 70 um thickness (ref: N. Wang Lab)
15 L ~ 75 um thickness (ref: N. Wang Lab)

7. Place a circular coverslip on top of the placed solution then flip over the dish. Keep the dish in
the incubator (37C) for 30 minutes. This will ensure that flat gel surface. For 196 kPa PA gels,
incubate at room temperature for 10-15 min because the reaction is fast and very exothermic.

Alternatively, place a pre-chlorosilanized coverslip on top of the polymer solution and incubate
for 30 minutes.

Chlorosilanization of glass coverslips:

1. Soak the coverslips in DCDMS for 5 minutes.

2. Remove excess DCDMS with KimWipes.

3. Rinse coverslips with DI water for 1 minute.

8. Flip over the dish and add DI water to cover the gel. Just add DI water to cover the gel if
chlorosilanized coverslip was used.

9. Carefully remove the circular coverslip with a razor blade.
10. To remove unpolymerized acrylamide, rinse twice in DI water, each time for 5 minutes.

11. Store the gel hydrated in DI water at 4C until needed.
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A.6. PA gel surface functionalization protocol
REFERENCES: (Pelham and Wang 1997; Tse and Engler 2010)

SUPPLIES
PA gel
Sulfo-SANPAH (Fisher Scientific, Pittsburgh, PA)
Type | collagen from rat tail (BD Biosciences, Bedford, MA)
50 mM Hepes (pH 8.5)
DI water

EQUIPMENT
UV lamp (365 nm; UVP B-100 High Intensity UV lamp); Vortex

PROCEDURE
1. Take a PA gel and remove liquid with Kimwipes. Careful not to touch the gel itself.
2. Pipette 100 uL of SANPAH onto each gel surface.
Sulfo-SANPAH (keep from light) = 50 mg
DMSO =500 uL
50mM HEPES =50 mL
*Add DMSO first, then slowly add the HEPES to the sulfo-SANPAH while vortexing.
3. Expose the dish to the UV light (365 nm) at a distance of 2-3 inches for 6 minutes.
Turn on the UV lamp and leave it on for 8 minutes. It takes roughly 30s-1.5min for the lamp to
fully turn on.
4. Wash 2x with 50mM HEPES.
5. Repeat #2 — 4.

6. Pipette 200 uL of the desired protein solution at a desired concentration. Protein solution is
made by diluting the stock protein solution in 50 mM HEPES at pH 8.5.

Collagen conc: 100ug/mL, 40ug/mL, 1 ng/mL
7. Let it activate overnight (> 18 h) at 4C.
8. Remove excess protein solution and rinse 2x with DI water.
9. Prior to seeding cells, sterilize the gel by exposing it to UV for 30 minutes in a sterile hood.

10. Store the gels at 4C until needed. However, using the coated gels right away is recommended.
DO NOT store gels for more than 2 weeks.
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A.7. PA gel collagen-coating quantification protocol

REFERENCES: (Engler, Bacakova et al. 2004; Engler, Richert et al. 2004)

SUPPLIES

PA gel; Glass bottom culture dishes; 2% BSA in PBS; PBS

Type | collagen from rat tail (BD Biosciences, Bedford, MA)
Primary collagen antibody (Abcam, Cambridge, MA)

Alexa Fluor® 568 secondary antibody (Invitrogen, Carlsbad, CA)

EQUIPMENT

Multiphoton laser scanning microscope (LSM 710; Carl Zeiss AG, Thornwood, NY)
PROCEDURE
1. Deposit known amounts of type | collagen on the glass microwell of glass bottom culture

9.

dishes then leave them to dry overnight. Also prepare a blank glass bottom dish to calculate
background fluorescence noise to later subtract from the determined fluorescent intensity
values.

Incubated in 2% BSA in PBS for 45 minutes to block nonspecific binding. When completed,
carefully remove 2% BSA in PBS solution with Kimwipes.

Incubate with primary collagen antibody (1:200 dilution) for 1 hr. When completed, wash 2x
with PBS.

Incubate with Alexa Fluor® 568 secondary antibody (1:200 dilution) for 45 minutes. When
completed, wash 2x with PBS.

Keep samples hydrated in PBS and covered with aluminum foil until ready to image. Image
right away to minimize photobleaching.

Take collagen-coated PA gels. Wash gels 3x with PBS.
Repeat #1-4 with these gels.

Take prepared glass bottom culture dishes and PA gels to the microscope to take fluorescent
images of the collagen layer.

Using ImageJ, compute average fluorescence intensity for all samples.

10. Create a calibration curve to determine the amount of surface-bound collagen.

64



A.8. AFM force measurement protocol
REFERENCES: (Engler, Bacakova et al. 2004; Engler, Richert et al. 2004)

SUPPLIES

PA gel (collagen-coated and uncoated) samples prepared on microscope slides
Blank glass microscope slide

DNP-S10 silicon nitride AFM probe (Bruker Corp., Camarillo, CA)

DI water; Hydrophobic pen

EQUIPMENT
MFP-3D AFM (Asylum Research, Santa Barbara, CA)

PROCEDURE

Get ready:
1. Turn on Igor software. Select ‘contact mode’.
2. Turn Laser on.
3. Turn light source on.
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Figure: MFP-3D Head

Figure A.2. A top-down view of the AFM head. Photo-Detector knob adjusts deflection. LDY
and LDX knobs control the laser position in y- and x-directions, respectively. Camera control
knobs are located near the LDY knob. The big wheel at the front end lifts the head up or down.

NOTE: The head is very heavy and needs to be handled with caution. Also pay attention to the
cables attached to the head because it is easy to snap off the cables.



1. Cantilever Calibration

NOTE: Always make sure the head is level! The bubble of the bubble top should be
at the center, slightly to the front.

NOTE: RED = Extension; BLUE = Retraction

Tip is in hard contact
with the surface;
repulsive regime Tip is far from the
g surface; no deflection

w

Force
[=]

™. Tipis pulled toward the
* surface - attractive regime

Probe Distance from Sample (z distance)

Figure A.3. An example of a force-indentation curve generated with AFM.

1. Place a clean bare glass microscope slide on the sample holder.
a. Draw a hydrophobic circle on the glass slide before loading.
2. Mount the probe on the probe holder.
a. The probe should not be too far back or too far out.
b. It should be about 1-1.5 mm away from the end of the clear probe mount.
c. From the side, the probe sits at a slightly slanted upward angle.
d. Once ready, place the probe holder into the AFM head.
3. Laser Alignment.
a. Find the laser spot and place it at the end of the tip to be used.
b. Adjust to get maximum sum signal.
c. Adjust deflection to zero.
d. Letitstand for a few minutes if deflection fluctuates. Deflection may be unstable
if there are charges on the surface or huge adhesion forces near the surface due to
a water layer on a rainy day, etc.
4. Check thermal peaks under the thermal tab. Verify that a correct peak exits within the
manufacturer specified drive frequency range.
5. Force calibration.
a. ‘Engage’. Zero the deflection then bring down the head until the tip touches the
surface, with a clicking sound from the software. Adjust Z voltage to be at zero.
b. Adjust settings: Trigger Channel
i. Trigger channel: DeflnVols
ii. Positive slope
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C.

li. Relative
iv. For soft cantilevers, change Force distance = 10 um
Trigger point =3V
Hit ‘Single Force’. It should generate a single force curve. Hit it one more time if
the tail is too long or is at an angle.
i. Bring out cursors with “Control +i”
ii. Locate them on the tail
iii. Set sensitivity = Virtual Deflection
iv. Zoom into the linear region of the curve.
v. Place the cursors on the linear region. The cursors should move together if
you move along the curve with arrow keys.
vi. Set sensitivity = DeftInVVols
vii. Check AmpInVols to see if it’s between 30 and 60. Write down this
number. Even if this number is greater than 60, it is okay as long as the
calibrated spring constant is close to the nominal spring constant.

6. Thermal calibration.

a.

oo o

e.

Physically lift head up from sample (turn the knob 10x). Deflection should change
as the head is moved up; however, it should stay stable.

Do thermal.

Fit to the peak corresponding to the specified drive frequency of the tip.

“Try fit’ until little to no change in spring constant. Record the spring constant.
Check Amplnvols. Record this number.

7. Transition to Liquid Mode.

o0 o

SKQ ~h o

Carefully lift head up.

Add a few drops of water on the probe and around it.

Pipette some DI water onto the pre-drawn hydrophobic circle on glass slide.
Place the head down carefully. You can see from the camera that the tip is now
submerged in water.

Make sure there are no air bubbles on the tip!

Adjust deflection and laser position to get good sum signal.

Wait 5 minutes or more for deflection to stabilize.

Do ‘Single force’ to create a force curve. It should look similar to the force curve
in air mode.

Check AmpInVols. It may shift quite a bit. Record this number. You will use this
number for any subsequent data analysis.

2. Force measurements of the gel samples

1. Make sure head is level. Also, disengage head so that the tip won’t be touching the
sample once the sample is loaded. The tip will get destroyed if head is too close to sample.
2. Load sample.
NOTE: Always do the stiff substrates first, then move to softer ones to minimize
damage to AFM probes.

a.
b.
C.
d.

Bring head down so that the tip is fully immersed in liquid.
Wait about 5 minutes for deflection to stabilize.

Engage the tip and find the surface, then withdraw.

Adjust force measurement settings.
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i. Velocity =1 pm/s
ii. Indentation depth =2 um
e. Hit Single force.
f. Hit withdraw.
g. Move the stage in x- and/or y-directions to locate the AFM probe on different
spots of the loaded samples. Repeat e-f. (N = at least 15 per sample)
8. When done, lift up the head.
9. Remove the sample. Load another and repeat as needed.

3. Saving the data files

Force tab -> ‘Review’.

Select force curves to be saved.

Modify x- and y-offset.

Menu on the very top of IGOR Pro: Select Data -> Save waves -> Save as delimited text.
Find the folder where the force data is saved.

Select the correct files to be imported then hit ‘Do it’. For Hertz force calculations, only
the ‘Ext’ files are required. (Red = extension; Blue = retraction).

ogakrwdE

4. Clean-up
1. Remove the AFM probe and clean the probe holder with an air spray or nitrogen spray to

remove any liquid. Put the holder back into the head.
2. Put everything back to where it was.
3. Keep the AFM chamber closed.
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APPENDIX B: CELL CULTURE AND ANALYSIS PROTOCOLS

B.1. HSC isolation protocol

REFERENCES: (Liang, Jansen et al. 2007)

SUPPLIES

Animals to sac:
WT Jax C57B6 mouse strain: 1 mouse

FACS Antibodies:

Lineage cocktail [CD5, CD45R (B220), CD11b, Anti-Gr-1 (Ly-6G/C), 7-4, Ter-119]
Sca-1

c-Kit

*All antibodies are purchased from eBiosciences.

Materials:

70% ethanol solution

Surgical tools — scissors, tweezers

Timer; Pen; Petri dish

Vacuum chamber — vacuum flask, plastic tubing, and glass pipettes for aspiration

Pre-cooled reagents — ACK lysis buffer, separation buffer, PBS/2%FBS (at 4°C)

PBS/2%FBS: 20 mL for temporarily storing femurs and tibias
40 mL for crushing and filtering bones
35 mL for quenching after lysis step
10 mL for miscellaneous use
40 um cell strainer

EQUIPMENT

Biological safety cabinet; Vortex; Centrifuge; Flow cytometer (Analyzer or sorter)

PROCEDURE

Isolation of BM cells from mouse:

1.

2.

3.

Sacrifice mouse via COsinhalation. (Make sure to bring 70% ethanol solution, surgical
scissors and tweezers, gloves, and a pen to the animal facilities lab.)

Remove tibia and femur (entire length incl. head of femur) from both sides. Remove any
attached muscle (via gentle Kim-wipe rubbing). Keep cleaned bones in PBS+2%FBS.
Place bones into (cleaned/autoclaved) mortar with some PBS+2%FBS. Gently crush the
bones using a pestle. Do not grind with continuous motion in the x direction: instead, use
a gentle up-and-down motion.

Pour PBS+2%FBS + ground bones through a 40um cell strainer into a 50ml conical tube.
Add more PBS+2%FBS and grind. Repeat until 40mL PBS+2%FBS is used up. While
doing this, also make sure to rinse mortar and pestle once in a while to collect all cells.
Spin down: 1400 rpm, 5 minutes, 4°C. Aspirate supernatant.
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Resuspend cells in 5ml ACK lysis buffer, vortex well. Let stand 5 min (no more!) on ice.
Quench with 35ml PBS+2%FBS.

Spin down: 1400 rpm, 5 minutes, 4°C. Aspirate supernatant.

Resuspend in PBS+2%FBS in 1mL. Count live cells from a 10uL aliquot (+10uL Trypan
blue) with a hemocytometer. For easy cell counting, dilute the cell suspension at least by
a factor of 5.

WT

Avg. count (hemocytometer grid)
Total # cells/mL

FACS analysis/sorting for further enrichment in LSK population: All steps done on ice

N

4.

Add Fc receptor blocking antibody to achieve 0.5 ug/mL concentration. Sit 10’ on ice.
Spin down: 1400 rpm; 5 minutes; 4°C. Aspirate the supernatant.
Resuspend in 1mL PBS+2% FBS.

For first time sorting or when compensation needs to be updated, divide the BM
suspension in volumes of 300u L containing 250,000 cells to generate control samples
listed in the following table.

# | FACS Tube Contents

1 | Unstained control WBM

2 | Pl control WBM, PI

3 | APC control WBM, Sca-1-APC

4 | PE control WBM, c-kit-PE

5 | FITC control WBM, Lin-FITC

6 | Stained sample WBM, PI, c-kit-PE, Sca-1-APC, Lin-FITC

Add antibody cocktails (Lin, Sca-1, and c-Kit); Sit 20 on ice.

Lin cocktail Dilution
CD5 1:200
B220 1:300

Mac-1 1:320
CD8a 1:200
Gr-1 1:350
Ter-119 1:320

Note) Dilutions when antibodies are at 0.5 mg/mL.
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Antibody cocktail Amount
Lin cocktail 7uL
Sca-1-PE 7uL
c-kit-APC 7uL
TOTAL 21 uL

. Add 100 pL of PI stock solution into 10mL PBS+2%FBS to make a P1 working solution.
Add 20pL of the Pl working solution to the cells. Mix. Quench with 2mL PBS/2% FBS
right away because Pl staining is instantaneous.

. Spin down: 1400 rpm, 5 minutes, 4°C.

Resuspend in 1.5mL PBS+2% FBS; pipette up/down, vortex to generate single cell

suspension.

Filter into new tubes. Use polypropylene tubes to minimize cell loss through cells
attaching to the tubes. Polypropylene is superior to polystyrene.

Flow analysis/sorting on each population.
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B.2. Cell viability assay protocol

SUPPLIES
Hydrogel samples with live cells
LIVE/DEAD Cell Viability Assay kit (Invitrogen, Carlsbad, CA)

EQUIPMENT
Fluorescence microscope (Leica DMI4000, Leica Microsystems GmbH, Wetzlar,
Germany)
PROCEDURE
1. Make a 500 pL working solution in PBS.
a. Add 1 pL ethidium homodimer-1, red
b. Add 0.6 pL calcein, green
2. Add 100 pL to each glass bottom culture dish.

3. Incubate for 15 minutes at 37 °C.

4. Image with a fluorescence microscope. Live cells are stained green and dead cells are stained
red.
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B.3. Fixed cell staining protocol

SUPPLIES

Samples with cells

3.7% formaldehyde

0.1% Triton X100

ITsignal FX (Invitrogen, Carlsbad, CA)

DAPI (Invitrogen, Carlsbad, CA)

Alexa Fluor® 488-phalloidin (Invitrogen, Carlsbad, CA)
Prolong Gold® (Invitrogen, Carlsbad, CA)

EQUIPMENT

Multiphoton laser scanning microscope (LSM 710; Carl Zeiss AG, Thornwood, NY)

PROCEDURE

NOTE.:

- All procedures performed at room temperature.

- 100 uL solution is used at each step unless otherwise stated.

- Leave the sample in PBS for about a minute per rinse.

- Use Kimwipes to remove excess liquid for the rinsing step.

- Do not use BSA with ITsignal FX as it may interfere with the effectiveness of the product.

1.

Fix sample in 3.7% formaldehyde for 15 minutes.
Wash sample 3x with PBS.

Incubate sample in 0.1% Triton X100 in PBS for 15 minutes.
Wash sample 3x with PBS.

Add 2 drops (~100uL) of ITsignal FX and incubate for 30 minutes. IT signal enhances
sample fluorescence signal while reducing background noise.

Wash sample 1x with PBS.

Dilute 5uL of methanolic stock solution (Alexa Fluor 488-phalloidin) into 200uL
PBS/ITSignal FX (150uL plus a drop of ITSignal FX) for each sample. Incubate sample in
this solution for 30 minutes.

Prepare DAPI solution (1:800 dilution). When 25 minutes of incubation has passed (5 min
before completion), place the DAPI solution to the sample.

After full 30 min of incubation, wash sample 3x with PBS.

To minimize photobleaching, add a drop or two of Prolong Gold antifade reagent. Cure for
24 hours at room temperature before storing at 4 °C.
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B.4. ImageJ: Cell spread area calculation protocol

SUPPLIES

Images of cells to be analyzed (either F-actin images or phase contrast images)
ImageJ (Free download available from online)

EQUIPMENT

Fluorescence or light microscope with 40x or higher magnification

PROCEDURE

1.

Open either a confocal image (fluorescence) or a phase contrast image. The image should
have a scale bar.

Analyze -> Set scale. Usually comes to 6.3 pixels per unit OR 63 pixels for 10 microns, but
will vary depending on the picture size and magnification used.

Image enhancement (Necessary for phase contrast images only): Steps #3-5

3.

Process -> Smooth OR Sharpen, depending on which one gives clearer, more defined edges
of the objects of interest.

Process -> Enhance contrast. Set it to 0.7%. If this doesn’t give defined edges, try 0.001%.

Image -> Adjust -> Brightness/Contrast.

Image -> Adjust -> Color balance (All colors).
Image -> Adjust -> Threshold color -> Hue settings reduces background noise quite well.
Adjust these settings until more defined edges are obtained.

Image -> Type -> 8-bit to make it a black & white image.

Image -> Adjust -> Threshold. Adjust until the objects of interest stand out and the
background noise level is minimized. Hit ‘Apply’.

Process -> Binary -> Make binary. A pop up window will appear. Do this once more. The
pop up window will not appear this time.

Using the wand tool, click an object of interest. If it has holes to fill, then fill them by
clicking ‘Cntl+F’. Fill until a uniformly filled object is selected.

10. Analyze -> Set measurements -> Check ‘Area’ and ‘Perimeter’.

74



11. Analyze -> Analyze particles -> Adjust range (usually 10 — Infinity works.
Increase/Decrease depending on expected cell size). Show “Outlines’.

12. Continue analyzing until only one object (or objects of interest) is identified. That is, objects
of interest being identified as multiple particles is NOT good. One cell should be identified as
one particle. Record computed area and perimeter for further calculations.

13. Save the thresholded image for record.
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